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Notice

|
It is hard to keep up with Microsoft. They are continually updating and
releasing newer versions of Word. Your presenter is most familiar with
Word 97 for the PC. I have been working with Word 2000 for the PC for
about a month and find that for our purposes, very little has changed. I am
fairly familiar with the Macintosh versions of Word, but did not have
access to a recent version in the preparation of this workshop. Word XP
has recently been released. While I have not seen it yet, I have faith that
the changes and additions made by Microsoft will not have a significant
effect on the material presented in this workshop.

It would have become a monumental task to include individual
instructions for all recent versions of Word. This booklet is designed to be
used with Word 2000. If you use a different version, the vast majority of
this material should still be accurate.

This entire booklet was produced using Word 2000.

Conventions
|
When you see text like ‘File - Save As’—it means that you should click
on the ‘File’ menu, then click on ‘Save As

When you are asked to click or hit a button with text printed on it, it will
be represented like ‘Shift’.

If the button has an icon, the name and picture of the button will be
provided as in: Click the “Text Box’ button

Thank You

A big thank you to Paul Rosenow (Manitowoc LHS *78) and the staff
of Rosenow Express Images in Glendale, California for printing this
handout. Taking special Word documents to be printed professionally adds
a great deal to the look of the finished product!
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Objectives

The bar has been raised! There was a time where the best the average Joe
could do to produce printed material was to use a typewriter. There were
very few options when it came to designing printed material. A first rate
church bulletin of twenty-five years ago may have sported a cross
composed of asterisks as its only non-textual element. Today personal
computers and word processing software such as Microsoft Word® give
users the tools to produce documents that equal professionally produced
documents.

Supplying the average person with the finest of sculpting tools and a
magnificent piece of marble do not assure that a museum quality sculpture
will be produced. To a lesser degree, this is the challenge that faces those
of us who must produce documents for public dissemination. The quality
of documents that is expected of us today is considerably greater than it
once was. The bar has been raised!

This booklet consists of two primary sections. The first discusses some of
the rules and principles of typography and graphic design. The second,
and larger portion, will demonstrate how to make use of the tools
contained in Microsoft Word to carry out these principles.

Upon completion of this workshop—and with some individual work at
home—participants will:

e understand some basic rules of text design.

e Dbe able to apply these rules using Microsoft Word to produce more
sophisticated documents.

e have a useful resource to refer to in the future.

Making Microsoft Word Sing iv WELS Tech 2001



Some Design Basics

It is important to remember the reason for producing printed
documents...to clearly communicate with our readers. Different
types of documents warrant different types of design. A business letter
does not need to “cry out” for the attention of the reader, whereas a VBS
flyer most certainly should be an attention grabber. The principles of
design apply to all types of printed media. What follows is a brief
summary of some brief summaries of the monstrous volume of research in
typography and design.

Unlearning what your typing teacher taught you

Those of us whose first keyboard was a typewriter have a few things to
unlearn. (These are just the guidelines, we’ll talk about how apply them
later.)

Use only one space after periods, commas, semicolons, and colons

Word processing fonts are—for the most part—proportional fonts. This
means that each letter takes up a different amount of space. See the section
on ‘Fonts’ that follows.

Use hyphens, en dashes, and em dashes appropriately
A hyphen (-) is used only to hyphenate words (duh!) as in “ multi-page”
or when breaking a word at the end of a line.

An en dash (-), so-called because it is the width of an uppercase N, is
generally used where the word “to” might be used (as in Oshkosh —
Appleton, 9:00 — 9:45 A.M., or 3 — 5 years).

An em dash (—) is twice as long as an en dash—the width of an
uppercase M—and is used as we might use parentheses—Iike right here—
or where you might use a colon. An em dash can also be used to indicate
an abrupt change of thought.

Use special characters whenever necessary (subscripts,
superscripts, fractions, etc.)

Simply because ‘H,O’ is better than ‘H20’, ‘%4’ is better than ‘1/4°, <32°°
beats ‘32-degrees’, etc. Besides, you can’t roll a word processor up or
down like you had to on a typewriter!

Use accent marks if it is part of the word
This fits in with the above special characters. For example: Nufiez or fiimf
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Don’t underline

Underlining was one of very few options for emphasis on the typewriter.
Use bold and italic for emphasis. If you want to underline, draw the line
in, that way it won’t interfere with the “descenders” of letters (the parts of
letters like g, p, j, and y that hang below the line). Look at these examples:

The goats play jai alai for the queen.

(underlined)

The goats play jai alai for the queen.

(drawn underscore)

Don’t use all caps in body text—only rarely in headings

This is the other old option for emphasis on a typewriter. Use boldface
to make something stand out. ALL CAPS ARE MORE DIFFICULT TO
READ, SO USE THEM SPARINGLY IN HEADINGS.

Don’t use spaces to align text

One reason to avoid this is that if you later change the font size, it messes
up the spacing as well. Another reason is that it just won’t work for
formatting columns with a proportional font (see the font section that

follows).

Tabs, indents, and tables are the proper ways to align text with a word

processor.

Use tabs properly—don’t use multiple tabs to space

On a typewriter we were taught to hit tabs multiple times. In word
processing software there are generally four types of tabs. You should
almost never need to hit the ‘Tab’ key twice or more in a row.

Use a one-em first-line indent when indenting paragraphs

Typesetters either don’t indent paragraphs (They will space between
them.) or will use a one em—equivalent to an en dash—instead. On a
typewriter we were generally taught to leave a five space or half-inch

indent.

Making Microsoft Word Sing
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Use hanging indents for numbered lists, bulleted lists, and the like

This

9. I will do one hundred
push-ups every day.

Not

9. I will do one hundred push-
ups every day.

10. I will remember so say
something nice every day.

10.1 will remember so say
something nice every day.

or or

M: In the name of the Father,
Son, and Holy Spirit

C: Amen.

M: In the name of the Father,
Son, and Holy Spirit

C: Amen.

Leave no widows or orphans

A widow is when a paragraph ends and leaves fewer than seven
characters on the last line.

An orphan is the last line of a paragraph that is carried onto the next
column all by itself.

This principle grows in importance depending on the circulation of the
document you are preparing. For newsletters, brochures, or handbooks this
deserves close attention. Adding or deleting a word, adding a space, or
changing the column length, usually corrects it.

You are the salt of the
earth. But if the salt loses its
saltiness, how can it be made
salty again? It is no longer

good for anything, except to be

thrown out and trampled by
men.

You are the light of the
world. A city set on a hill
cannot be hidden. Neither
do people light a lamp and
put it under a bowl. Instead
they put in on its stand, and
it gives light to everyone in

the house.

In the same way, let
your light shine before
men, that they may see
your good deeds and
praise your Father in

heaven.
~Luke 5:13-16

There is one widow and one orphan in the box above—can you find them?
(Pardon the sloppy columns. I had to force the widow and orphan out!)

Adjust the spacing between paragraphs; don’t use carriage returns to
space paragraphs

Here is another tough one to get used to! Look at a book that does not
indent paragraphs. You will see that the space between paragraphs is less
than a full carriage return.

Making Microsoft Word Sing
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Either indent paragraphs or leave space between paragraphs
Either will show the start of a new paragraph. Using both is excessive.

Don’t use hyphens as leaders in lists—use bullets or dingbats
Hyphens and asterisks were about the only choices for leaders on a
typewriter. Word processing software provides many options.

Bullet - a little marker ( like: * ) used instead of numbers with lists or
between words

Dingbat — small ornamental symbols ( like: LITTTTTTT] )
that can be used to replace a bullet or as an ornament. Monotype Sorts or
Wingdings are two common dingbat fonts.

Use small caps for A.M. and P.M. (not A.M. or p.m.)

This one seems picky but, if you look at typeset text, you’ll notice that it is
followed consistently.

Fonts

Proportional and Non-Proportional Fonts

Most of the fonts on your computer are proportional fonts—each character
takes up a different amount of space. In non-proportional fonts (like
Courier), each character takes up the same amount of horizontal space.
Typesetters rarely use non-proportional fonts unless there is a compelling
reason (like a word-search puzzle). See these examples:

This is Courier, a This is Arial, a
non-proportional proportional font.
font. Notice how Notice how very little
everything lines up? lines up?

I LoveXOXO0OX ILOVGXOXOX

WELSTechXO
WELSTechXO

atFVLXOXOX

at FVLXO0OXOX

Proportional fonts are the reason we don’t need two spaces after a period
or colon in a word processor.

/42 Don’tuse non-proportional fonts in documents unless you
have a good reason. Proportional fonts have much more eye
appeal.
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Serif and Sans Serif Fonts

Most fonts can be classified as either serif or sans serif. Serif fonts have
the little points on the ends of the letters. Sans (without) serif fonts do not

have them.

X

Serif

Sans
serif

Studies have found that serif fonts are much more readable for large
blocks of printed text. The reasons why aren’t clear. Sans serif fonts, on
the other hand, are more legible—easier to recognize—than are serif fonts.

For this reason it is wise to follow these guidelines:

P Use serif fonts for large blocks of text. Use sans serif fonts for

headlines or section headers.

ﬁ Don’t use more than two fonts on a page. If you use two

fonts, make sure one is serif and one is sans serif.

There are times to violate these guidelines but, for those of us without
typographic or design training, these are good rules of thumb to follow.

Making Microsoft Word Sing
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The Four Basic Principles of Design

Contrast

There are volumes and volumes of design principles. Robin Williams has
distilled them into four general principles that are invaluable when
producing documents of all kinds.

Differences on the page get attention. Whether they are differences in font,
size, line thickness, or color—contrasts are, by definition, meant to be
noticed. A simple guideline is: Don’t contrast by using elements similar or
close in appearance—make it stand out!

CLHS CLHS

Gthéetics || Mthletics

Which one do you think looks better? The layout is basically the same.
Where they differ is in the contrast between the typefaces. The example on
the left contrasts both in the type style (serif vs. script) and the boldness of
the type. The example on the right contrasts in type style (serif vs. sans
serif) but is very close in boldness of type. The left example demonstrates
greater contrast.

/2 When contrast is your objective, let there be no doubt about it.
Make it obvious.
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Alignment

Everything you place on a page should have a visual connection with
something else on the page. Elements may be separated by distance, but
there should be an invisible line that connects them. Which of these
business cards shows better alignment?

Chester Schmidt (909) 555-1234

Wild Gmar’s oDelZ

1313 Ivy Road Wildomar, CA (909) 555-1234

Wild Gmar’s opeli

Chester Schmidt

1313 Ivy Road
Wildomar, CA

Repetition

The card on the right follows a strong left alignment. Even though the
elements are separated, our eye can still pick up the line. None of the
elements of the left card align with anything.

Most of us are familiar with aligning text. We can align right, left, center,
or justify. A couple of cautions: 1) Many people have a tendency to center
too much. Consider right or left aligned text. 2) Many people also have a
tendency to justify—straight right and left margins—way too much.
Justified alignment only becomes a problem if the columns are too narrow.
This tends to make “rivers” of white space through the columns.

ﬁ Always align elements on a page with other elements. Even if
separated by distance.

Repetition simply stated is consistency. Whether producing a newsletter,
report, or brochure, we need to consistently repeat aspects of the design
throughout the entire document.

As I compose this document there are many obvious lacks of consistency.
One of the final tasks will be to “clean it up” and bring a unified look to
the entire document. You should be able to tell from looking at any
individual page that it is part of the whole.
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Proximity

Be cautious of getting too complicated in your designs. Most highly
effective designs are more simple than they are complex.

L, Repeat some aspect of your design throughout your entire
document. Be consistent in how you do your layout and

The principle of proximity is that we group related elements together. If
elements are not related, then they should not be in close proximity to each
other.

In the prior example of ‘Wild Omar’s Deli’ business cards, the card on the
right also uses proximity to group related information together. All the
contact information is grouped near the bottom, while the identifying
information of the business and individual are closer to the top.

When we group related items together they become one visual unit. This
gives you a more organized and uncluttered document.

When producing text-based documents, pay attention to how you use
proximity of text and headings. If the heading is too far away from its text,
it can create confusion. Don’t’ make you readers think about the
formatting—make it obvious.

Many people are under the impression that white space is a no-no. When
used well, white space is one of the most effective design tools.

ﬁ Group related elements together to create visual units.

Making Microsoft Word Sing 8 WELS Tech 2001



Formatting Text
______________________________________________________________________|
This section describes how to get Word to achieve the design principles
just described.

Tabs and Indents

Proper use of tabs and indents is perhaps the biggest step to professional
looking documents. Failure to get things to line up is one of word
processing’s biggest frustrations.

Here are some important markers to know that are located on the text
ruler:

-ﬂ\/a—.

first line indent i —
hanging indent : o
left indent markﬁ a— right indent marker

Setting Tabs

There are several ways to set tabs. The quickest and easiest is to place
them on the text ruler just above the work area. That is the technique
described here.

To set tabs

1. Drag to highlight the paragraphs (portions of paragraphs are
sufficient) to which the tab(s) will be applied

2. Click the tab button L] (at the extreme left end of the text ruler)
until it shows the type of tab desired (see below)

3. Click and drag in the white ruler area to position the tab

4. Release the mouse button when properly positioned

Left align tabs — L] this tab marks the left edge of the text which
follows the tab

Right align tabs — 4] this tab marks the right edge of the text that
follows the tab

Center align tabs — 4] this tab marks the center of the text which
follows the tab

Decimal align tabs — ] this tab marks the decimal point (or period)
of the text which follows the tab (If there is no decimal
point or period, this tab functions like a right align tab.
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Setting Indents

For the entire document
1. File > Page Setup
2. Enter values for the margins in the boxes in the dialog box
3. Click OK when done

For part of a page (like a large quote)

1. Drag to select the paragraphs (portions of paragraphs are
sufficient) that are to be indented

2. On the ruler, drag the left indent marker to set the left margin
3. Drag the right indent marker to set the right margin
For the first line of a paragraph

1. Drag to select the paragraphs (portions of paragraphs are
sufficient) that are to be indented

2. On the ruler, drag the first line indent marker to the desired indent
Hanging indents

A hanging indent is when the first ¥ . | IR S E.A
line of a paragraph is " :
“outdented”—further to the left
than the other lines of the

9.+ will- do-one-hundre d-push-
upsevery-day |
+10. =+l willtemember-so-say

paragraph. Word will automatically something nice-svery day. |
make hanging indents for bulleted orq

and numbered lists, but it is often R

less frustrating to set them L

yourself. F S p— : e

MI:+Inthe name of the Father, 3ot -
atd Holy-Spirit]
Ci+ Amend

The figure at left shows the
positioning of the tabs and markers
to make hanging indents for
numbered lists and text lists. You 1

can sometimes get away without

the left tab on top of the left indent marker, but it is a good idea to put
it in nonetheless.

Position them by dragging as described above.
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Using Styles
Styles allow you to apply font type, font style, font size, tabs, indents, etc.
to a block of text. This can be a tremendous time saver!

I have found that it works well to type a paper making use of the default
styles. Then I can modify them when I’m finished. When you modify a
style, it changes all the blocks of text of that style in a document.

To apply a style

1. Click to place the cursor in the paragraph to which you would like
to apply the style

2. Click on the pop-up list of styles in | Mermal -
3. Click on the desired style

To make a new style

1. Drag to select the text that contains the formatting you want to use
for your style

J Marmal -

2. Click inside the ‘Style’ box

3. Type over the existing style name to create the name for the new
style

4. Press ‘Enter’

To modify a style
1. Format - Style

Click the ‘Modify’ button to open the ‘Style’ window

Click the ‘Format’ button to open the ‘Modify Style” window
Select the component of the style that you would like to modify
Make the change to the style in the dialog box

Click OK

Repeat steps 3-6 until all changes are made

Click OK in the ‘Modify Style’ window

Click ‘Apply’ on the ‘Style’ window

A U R o
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Using Sections

If your document has distinct parts you may want to divide it into sections.
Sections are necessary if you want to number different parts with different
page number formats. For example, this document has separate sections
for the title page, table of contents, and the body. Note the different page
numbers.

Insert a section break
1. Place the cursor where you would like the break to occur

2. Insert = Break

3. Click the radio button for ‘Next page’ if you want to start a new
page after the break OR Click the radio button for ‘Continuous’ if
you don’t want a new page.

4. Click OK

Pagination

In the days of typewriters we typed in the page numbers as we went along.
This does not work well in Word. If we make a change here or there our
page numbers are no longer where they belong.

Basic Page Numbers
If you have no sections to your document follow these steps:

1. View - Header and Footer

2. The cursor jumps to the header region (note that other text is grayed
out) and the format header and footer bar appears. If you want to
place the page numbers in the footer scroll to the bottom of the
page or press the ‘Switch between header and footer’ button ——

3. Place the cursor where you want the page numbers to be placed,

and hit the button on the toolbar

4. 1If you want a different format click the button.
Click OK
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Advanced Page Numbers

If your document has sections that you want formatted differently, follow
these steps:

1.
2.

Insert > Page numbers

Select the position and alignment from the pop-up windows in the
‘Page Numbers’ window.

Click OK—You now have numbered the entire document. You
must now format each section individually

Place the cursor anywhere in the section to be formatted

Insert > Page Numbers

If you do not want the first page of the section (like a title page)
numbered, then uncheck the box labeled ‘Show number on first

page.’
Click the ‘Format’ button
Choose the format for you page numbers from the pop-up list

If you want the numbering in the section to start at a particular
number, make sure the ‘Start at’ radio button is checked and enter
the appropriate number OR if you would like numbering to
continue from the previous section check the ‘Continue from
previous section’ radio button

10. Click OK
11. Repeat steps 4-10 for each section of the document.
12. Click OK again

Formatting Paragraphs

It is easiest to control margins and indents of paragraphs from the ruler
(see ‘Tabs and Indents”). To control the amount of space before or after
paragraphs, bulleted or numbered lists, and even table cells, follow these

steps:
1.
2.

Format - Paragraph

Use the ‘Spacing’ section to insert space before and/or after
paragraphs. The preview window gives you a feel for how it will
look. You can also modify the line spacing from the pop-up
window.

Click OK
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Bullets and Numbering

Word makes formatting bulleted and numbered lists a snap.

1. Select the paragraphs to be bulleted or numbered

2. Click the -*=_ button or the

41—
T —
T —

button whichever applies

For more complicated needs, use tabs and hanging indents as described
earlier.

Inserting Symbols

Some fonts have hundreds of special characters available for use. There
are two ways to access them:

Insert symbol from menus
1. Place the cursor where you would like the symbol inserted
2. Insert > Symbol

3. Select the appropriate symbol from the table (You can use the pop-
up list to select from different fonts.)

4. Click ‘Insert’

Insert symbols from keypad

As a general rule, it is quicker to use the keyboard for operations rather
than the mouse. With a chart of special characters (see the “WELS Tech
2001 Word Resources’ web site in the ‘Links’ section) follow these steps
to insert special symbols:

1. Place the cursor where you would like the symbol inserted
2. Hold down the ‘Alt” key

3. Type 0 (zero) and the ASCII number from the chart—for example,

to insert an emdash you would hold down the ‘Alt’ key and type
0151

4. When you release the ‘Alt’ key, the character is inserted

This may seem complicated, but it is pretty easy with practice. You may
want to keep a PostIt™ note with the numbers of your common special
characters stuck to your monitor.
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Footnotes and Endnotes

I hated footnotes above all else in the typewriter era. I would always forget
to put them in until there was not enough space left at the bottom of the
page. It is incredibly simple to insert footnotes or endnotes with Word.
You will need to format the footnotes or endnotes to fit the style guide that
you are following. Make it a style!

1. Place the cursor where you want to insert the reference number

Insert > Footnote

Select the appropriate radio button for footnote or endnote (Click
‘Options’ if there are some special formatting needs)

Click OK

5. Enter the footnote or endnote information (the cursor jumps there)

Scroll back to your original spot and continue typing

Table of Contents

If you’ve got a long paper—Ilike this one—with lots of headings, Word
will make a table of contents for you in seconds (an index is another
option).

Inserting a table of contents

It is best to wait until your paper is completed, since you must manually
update the TOC and it is easy to forget.

1. Place the cursor where you would like the TOC to be inserted

2. Insert = Index and Tables

3. Click on the tab for ‘Table of Contents’

4. Select the leader type from the pop-up menu (those
characters........ that line up the page numbers)

5. Select the number of levels you want in your TOC (this document
has two levels)

6. Ifyou have specific formatting needs click on ‘Options’

7. Click OK
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Updating the table of contents

If you make changes to your document, you should update the TOC. It is
amazing how even minor changes can impact the TOC.

1. Scroll to the TOC

2. Click to the left of the TOC (the entire table should become
highlighted)

3. Press F9

Using Images

Although Word is not intended to be a desktop publishing application like
Microsoft Publisher or Adobe PageMaker, it is relatively easy to include
images in your documents.

Placement

Word 2000 makes it quite simple to insert a picture.

Insert clip art from Word collection
1. Insert - Picture - Clip art

2. Choose the desired image from the collection

3. Click on the desired image

4. Click the Insert image button when it pops up &=
5. Close the Insert ClipArt window

You may be taken aback at what inserting the image has done to your
formatting. Don’t worry (yet)! The following section titled “Text Wrap”
will help to get it looking nice.

Insert image from a file
1. Insert &> Picture - from File

2. Use the navigation tools to locate the file on your computer
3. Click on the file to select it
4. Click the ‘Insert’ button

You may be taken aback at what inserting the image has done to your
formatting. Don’t worry (yet)! The following section titled “Text Wrap”
will help to get it looking nice.
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Resizing Images
It is often the case that the inserted images are not the proper size needed
in your document. To avoid distorting images follow these steps.

1. Click on the image to select it (tiny boxes called “handles” should
appear around the image)

2. While holding the ‘Shift’ button down, drag a corner handle
diagonally until the image is the proper size

3. Release the mouse button

Text Wrap
Managing text wrap has been greatly improved in Word 2000. Text wrap
determines how an image interacts with text. An image may:

e be inserted ‘In line with text’ much like a character from the
keyboard (The images of buttons on this and preceding pages were
inserted in line.).

e have a ‘Square’ wrap style where the text will flow around the
image as though the image were rectangular in shape.

e have a ‘Tight’ wrap style where the text will flow following the
contours of the right and left edges of the image.

e be inserted ‘Behind text’—in this case the image will not alter the
flow of text, but will appear to be behind it

e be inserted ‘In front of text’—in this case the image will not alter
the flow of text, but will appear to be on top of it

If these descriptions are unclear, there are preview images on the ‘Layout’
tab that give you a feel for how they work.

When working with large images, I have found it to be simplest to use the
‘Behind text’ or ‘In front of text’ options; making room by using extra
carriage returns. The design gurus would frown, but it is the easiest way
that [ have found.

To set the text wrap for an image

1. Double-click on the inserted image (the ‘Format Picture’ window
opens)

Click on the ‘Layout’ tab if not already selected
Click on the desired type of text wrap
Click OK

Drag the image to position it

A
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Print Quality

The print quality of images from clip art collections is generally excellent
for printing. If there is a problem, it generally arises from enlarging an
image too much. This can lead to a ‘fuzzy’ quality when printed.

In the age of the Internet, more and more people are using the Internet as a
source of images. Free clip art can be found on the Internet. Two cautions
are in order, however. Images from web pages are often formatted for
display only on monitors (72 pixels/inch). They generally won’t look good
when printed. A second caution is that Internet content—even a personal
web site—is covered by copyright law.

Advanced Formatting Techniques

“Advanced” probably isn’t the best word, but these are some useful tools
that most Word users fail to make use of.

Using Tables

Tables are very versatile layout tools. They can be used to organize text
and images in a variety of ways.

To insert a table
1.

2.
3.

Place the cursor where you would like to insert the table

Click on the ‘Insert Table’ button = on the toolbar

Drag in the pop-up table to indicate the number of rows and
columns desired for the table

For larger tables use ‘Table = Insert - Table’ from the menus.

To format table borders

You can change the borders (or have no borders) on your table to add to
its appearance. There are buttons on the tool bar, but for formatting tables,
I prefer to work from the menus.

1.
2.
3.

Click to place the cursor anywhere inside the table
Format - Borders and Shading

Select ‘Table’ from the ‘Apply to’ pop-up window if it is not
already visible

Experiment with styles, colors, etc. to get the desired effect (This is
a good area in which to invest some play time!)

Click OK
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To add padding to cells of a table

1. Drag to select the desired cells

2. Format - Paragraph

3. Inthe ‘Paragraph’ window add a few points (2 — 4 is usually about
right) in the space before and after—this keeps the cells from

looking crowded

4. Set the desired alignment for cells in the alignment pop-up window

5. Click OK

To merge cells in a table

Combining cells into larger cells gives you great flexibility.

1. Drag to select the cells to be merged

2. Table > Merge Cells or Clice the ‘Merge Cells’ button B3 on

the toolbar

Holy Week Service Schedule

Maundy Thursday 6:00 P.M.
April 4 7:30 P.M.
Good Friday 1:00 P.M.
April 5 6:00 P.M.
Easter Sunday 6:30 A.M.
April 7 8:00 AM.

10:30 A.M.

Sample table
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Text Boxes

Text boxes are very useful when putting together newsletters or brochures.
They are resizable boxes of text that can be moved at will. You can
modify the fill and stroke as you see fit. Linked text allows text to spill
from one text box to the next.

To insert a text box
1. Click the ‘Text Box’ button from the Drawing Toolbar or
Insert > Text Box

2. Use the cross-hairs cursor to drag the approximate location of the
text box

3. Type text into the box

To format a text box
. Click in the text box to select
2. Format = Text Box

Click the ‘Colors and Lines’ tab to format fill and stroke of the
textbox

4. Click the ‘Text Box’ tab to set internal margins

Click the ‘Layout’ tab to set the text wrap behavior (see ‘Text
Wrap’)—you will notice that the ‘In line with text’ option is
grayed-out (If you wanted in-line text, you wouldn’t need a text
box!)

To place a text box
1. Click inside the text box to select it

2. Move t:he cursor over the outside border until the cursor looks like

5

this B
3. Click and drag the text box to the desired location
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Linked Text

When doing layout with newsletters or brochures, you may want to have
text flow from one text box to the next.

To link text boxes
1. Be sure both text boxes have been created (one is most likely
empty)
2. Click inside the first text box to select it—the ‘Text Box’ tool bar

should appear (if it doesn’t, right-click a blank area of the toolbar,
then click ‘Text Box’ from the choices)

3. Click the ‘Create Text Box Link’ button "= on the ‘Text Box’
toolbar

4. The cursor should become a “pitcher” shape ~ **, move the
cursor over the target text box and click

Envelopes — Mail Merge

Envelopes

Many of the letters we send are not parts of mass mailings.So it isn’t
always practical to use mailing labels. Word can print mailing and return
addresses right on the envelope.

1. Click to place the cursor in the mailing address of your letter
2. Tools = Envelopes and Labels

3. Click on the ‘Envelope’ tab if is not already selected

4

The mailing address should have been automatically added—type
in a return address if desired (Word will offer to save it for future
envelopes)

5. Place an envelope in the feeder tray of your printer (There is
usually an icon etched into the printer tray to show the proper
envelope orientation.)

6. Click ‘Print’

Making Microsoft Word Sing 21 WELS Tech 2001



Mail Merge

Word’s mail merge feature allows you to paste in data from external
databases or spreadsheets (like Access, Excel, and others). It is great for
sending letters to groups of people (thank-you’s, meeting reminders, etc.).
Here’s how to make a mail merge form letter. You must have all necessary
data previously entered into a database. For our purposes, we will use
Microsoft Access.

1.

Type your letter—keeping in mind where you will insert
information from the database

2. Tools - Mail Merge

® N » ok

10.

11

14.

15.

16.

Click the ‘Create’ button by step 1 on the “Mail Merge Helper’
window

Click ‘Form letters’

Click ‘Active Window’ button (to use the letter you just typed)
Click ‘Get Data’ by step 2 on the ‘Mail Merge Helper’ window
Select ‘Open Data Source’ from the choices

Navigate to the database file on your computer (If the file appears
to be missing, make sure the proper file type is selected in the ‘File
type choices’ pop-up window)

Click ‘Open’

Click to select the table or query that contains the needed data from

your database (a different database may be structured differently
than Access)

. Click OK
12.
13.

Click ‘Edit Main Document’

You are returned to the window with your letter. The mail merge
control buttons should have appeared on the bottom of the upper
toolbar.

Select the location for the first insertion (if you are replacing
existing text, highlight it—otherwise put the cursor where you
would like to insert the data)

Click the ‘Insert Merge Field’ button from the toolbar and select
the field from the database which contains the information (the
field name will be inserted like this: <<NAME>>)

Repeat steps 14-15 until you have inserted all the data fields
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o
17. Click the ‘View Merged Data’ button "™ to see the letter with
data inserted

18. Navigate to other merged letters using the mail merge navigation

I 4|1 ||> b

buttons as seen here

19. Verify that things are correct, then print as you would a normal
letter

Time Savers
]

This section contains some tips that can increase your productivity and get
you away from that computer sooner.

Customizing the Toolbar

Unless your screen space is on the small side, I’d suggest having buttons
for all features that you use visible on the toolbar. Here is how to
customize:

To customize the toolbar
1. Right-click on the toolbar

2. A list pops-up to show which toolbars are already selected
(checked) and those that are not visible (unchecked)

3. To show or hide a toolbar, check or uncheck the box as needed
4. You can move toolbars around by dragging—toolbars can be on

|

the desktop or in the toolbar area simply drag them around by = or

Macros

If you find yourself repeating the same keystrokes and mouse clicks over
and over, you might be a candidate for a macro. Macros automate a series
of tasks and are accessed either by a special keyboard combination or from
the menu. As a math teacher, I recorded a macro to start the Microsoft
Equation Editor to insert mathematical equations.

Recording a macro

1. Practice the steps you are going to record—if you make a mistake,
that too will be recorded

2. Tools 2 Macro = Record New Macro
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3. Several important choices need to be made in the ‘Record Macro’
window

a. in the ‘Macro name’ box, enter a short descriptive name for
your macro

b. decide if you want to access the macro from the toolbar or
the keyboard and click the appropriate button

c. if this is a macro that will be used in future documents,
select ‘All Documents’ from the ‘Store macro in” box—if
you will only use it in this document select the name of the
current document

4. If you don't want to assign the macro to a toolbar, a menu, or
shortcut keys, click OK to begin recording the macro.

To assign the macro to a toolbar or menu, click ‘Toolbars’.
In the ‘Commands’ box, click the macro you are recording,
and drag it to the toolbar or menu you want to assign it to.
Click ‘Close’ to begin recording the macro.

To assign the macro to shortcut keys, click ‘Keyboard’. In
the ‘Commands’ box, click the macro you are recording. In
the ‘Press new shortcut key’ box, type the key sequence,
and then click ‘Assign’. Click ‘Close’ to begin recording
the macro.

Perform the actions you want to include in your macro.

You can use the mouse to click commands and options, but the
macro recorder cannot record mouse actions in a document
window. To move the insertion point or select, copy, or move text,
for example, you must use shortcut keys.

7. To stop recording your macro, Tools - Macro - Stop
Recording

Templates and Wizards

Templates are frameworks upon which we build a document. A new blank
Word document is built from the “normal” template. Word comes with a
variety of different templates for letters, newsletters, fax cover sheets,
memos, resumés, etc. When you go File 2 New, the ‘New’ window
opens. There are a variety of tabs that contain numerous templates. It is
worth taking some time to look through what is there. The only downside
is you will begin spotting those templates in other people’s documents—
we all want to be unique, right?

It is often more useful to make your own templates. We often produce
similar documents on a regular basis—newsletters, church bulletins, faxes,
letters—you name it!
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Wizards are scripts that walk you through the process of creating a
resumé, web page, brochure, or some other process. Like templates they
can help you produce professional quality work quickly. They are
accessed through the ‘New’ window in the same way that templates are.
They to are worth exploring.

To create a template

It is often easiest to begin with a document that you have formatted just
the way you like it.

1.

2.
3.
4
5

Tidbits

Cut most of the content out replacing it with some generic text
File > Save As

In the ‘Save as type’ pop-up list, select ‘Document Template’
Select a location to save

Click ‘Save’

Here are some tips I’ve picked up that make life with Word a bit easier:

Learn to use keyboard shortcuts for frequently used commands. It
is much quicker not to reach over and grab the mouse.

Produce the text of your document first, then do the formatting.
It’s hard to concentrate on both tasks at once. Do try to place tabs
and apply generic styles as you go.

Get used to working with the “invisible” characters showing.

(Click the ! button on the toolbar.) It takes a bit to get used to
seeing them, but it is easier to see reasons for alignment errors
while they are there. It also encourages you not to use multiple tabs
or spaces to line things up.

Save your work often. Word has an auto recovery feature that
works pretty well, but it is better to save you work at regular
intervals—particularly after an especially difficult section.
Remember—Microsoft products will crash!

Save important work in more than one place. Make permanent
backups of your important files regularly. After a few months the
information you’ve stored on your computer is much more
valuable than the hardware and software.

Word’s AutoCorrect feature can be annoying—it tries to be too
helpful. Go to Tools = AutoCorrect you can find and turn off
your least favorite “helpers.”
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e Double-click a word to select it.
e Triple-click to select an entire paragraph.

e [fyou type two hyphens between words, leaving no spaces, Word
will automatically insert an em dash. If you type two hyphens
between words, and leave spaces on either side of the hyphens,
Word will automatically insert an en dash.

e Ifyou want to apply a particular format to portions of (or entire)
paragraphs, highlight some text with the format you would like to

copy, click the ‘Format Painter’ button < , then drag to “paint”
that format on other text. If you double-click the ‘Format Painter’
button, you can “paint” multiple sections.

Resources
]

That Paper Clip Guy

As irritating as he can be, he usually has the answers to your questions.
Just type in a few key words about what you need to know and he will
help you out. Feel free to send him away by right-clicking him and
selecting ‘Hide.” You can bring him back by clicking the ‘Help’ button

ki from the toolbar. He was a big help to me in writing this up.

There are all kinds of web resources to help you out with Word questions.
Here are some that I like:

Microsoft’s Own Word Site --
http://www.microsoft.com/office/word/default.htm - as good a
place as any to look for info

MS Word MVP FAQ Site- http://www.mvps.org/word/ a Word
newsgroup lots of questions, answers and resources from people
with no apparent lives

PC World Answers 15 Nagging Word Questions -
http://www.pcworld.com/hereshow/article/0,aid,14731,00.asp -
you’ll find at least one or two that will be of use

WELS Tech 2001 Word Resources -- http://www.clhs-chawks.org/word
- I’ve put a few resources here. If you have something that others
might find useful, email it to me and I will post it!
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Miscellanea
]

References

In the opening section on design I drew heavily from three of my favorite
sources:
Parker, Roger C. (1987). The Aldus Guide to Basic Design. Seattle,
WA: Aldus Corporation.
Williams, Robin. (1992). The PC Is Not a Typewriter. Berkeley, CA:
Peachpit Press.
Williams, Robin (1994). The Non-Designers Design Book. Berkeley,
CA: Peachpit Press.
If you are interested in learning more about designing all types of media,

Robin Williams’ (not the comedian) books are excellent. There is a great
deal of ground I did not begin to cover in this workshop.
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